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Welcome
Hello, and welcome to the SoftStep3 manual. The purpose of this document is to provide a resource with 
helpful, detailed information regarding the use of the SoftStep3 and SoftStep Editor software.			 

Questions? Feedback? Contact Us!
Any questions or feedback that may come up regarding the SoftStep or its software can be directed to us 
here:			 

• Technical Support: support.keithmcmillen.com

• General Questions: contact@keithmcmillen.com	

Where To Download the Editor software					   
SoftStep software can be downloaded on the KMI website at: https://www.keithmcmillen.com/downloads/

What’s In The SoftStep3 Package?				  
The following items are included in each SoftStep3 box:

• SoftStep3

• USB A to USB C cable (3m)

• SoftStep bag						    

What’s new with SoftStep3?
The SoftStep3 is the latest addition to our line of MIDI contoller pedals. SoftStep3 has a USB-C jack to 
connect to a computer or mobile device. Unlike previous versions, SoftStep3 does not have a KMI MIDI 
Expander port, instead it has a TRS MIDI Out jack. As a result, the SoftStep3 no longer has a serial MIDI In 
connection and can only receive MIDI IN over USB. We have added a CV port with 2 CV outs for connecting 
to modular and analog synthesizers.

The new SoftStep Editor software is fully backwards compatible with previous versions of the SoftStep 
hardware. In this manual, references to the TRS MIDI Out port can be understood to apply to the MIDI 
Expander port as well.



SoftStep3 Hardware

d9d8d6



SoftStep3 Hardware

10

SoftStep3

1.1 Hardware Overview

(1) Keys

Keys are where the action happens. Step on these to make the SoftStep perform its defined functions.

Each key has a green and red LED (at the northeast corner of the key) for visual feedback.

(2) Nav Pad

Press left or right to change presets. Up/Down can be programmed to perform a number of different 
functions.

(3) Display

The SoftStep3 display can show what preset is currently loaded, the name of an activated key, and real-
time parameter values.

(4) USB-C

Connect to a computer or tablet to send MIDI over USB, or connect to a power supply when using 12Step 
without a computer.	

(4) TRS MIDI Out

Connect to hardware via TRS MIDI Out (Type A). A TRS-MIDI Adapter is available in the KMI Step Adapter 
Kit (sold separately).

(5) CV Out

Stereo jack sends 2 CV Outs.  A 1/8” stereo to 2 mono jacks adapter is available in the KMI Step Adapter 
Kit (sold separately).	

(7) Pedal Input

Used to connect an expression pedal to the 12 Step. All input should use a 3.5mm (1/8”) TRS cable to work 
properly. An Expression Pedal Input Adapter is available in the KMI Step Adapter Kit (sold separately).  
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1.2 Connecting SoftStep3
SoftStep3 features new options for connecting to your hardware. New to the SoftStep3 is a USB-C connection 
for sending USB MIDI, as well as TRS MIDI Out and CV Outputs for connecting to MIDI hardware and analog 
synthesizers.

USB MIDI
Connect the SoftStep3 to a computer or tablet with the included USB A-to-C cable. SoftStep3 will receive 
power from the computer or tablet.

Note: SoftStep3 can be used with a USB hub connected to a computer or tablet. It is highly recommended 
to use a powered USB hub, not a bus-powered hub. Bus-powered hubs may not be able to provide 
enough power to the SoftStep3 to function properly.

Use the USB-C jack to power the SoftStep3 when not using a computer.

TRS MIDI Out
Connect SoftStep3 to MIDI hardware via the TRS MIDI Out jack. Use a TRS-MIDI Adapter (Type A) to 
connect to 5 pin MIDI hardware. 		

CV Out 1/2
SoftStep3 can control modular and analog synthesizers with Control Voltage signals.

The CV Out is a TRS jack. CV1 is sent on the tip and CV2 is sent on the ring.

The default setting outputs Gate (CV Out 1) and Pitch (CV Out 2).

Expression Pedal Input
Plug an expression pedal into the SoftStep3 and use it as a MIDI control source. Use a 1/4” to 1/8” TRS 
adapter cable to connect the SoftStep3 to the expression pedal. The range of the expression pedal can be 
calibrated with the SoftStep Editor software.

Note: Volume pedals do not work with the SoftStep or any KMI controller with expression pedal input. 
Only expression pedals are compatible.

KMI Step Adapter Kit (sold separately)
The KMI Step Adapter Kit contains all the adapters you need to connect your SoftStep3 to external 
devices. The Kit includes a TRS MIDI Out adapter, a CV 1/2 breakout adapter, and a 1/4” to 1/8”TRS 
expression pedal adapter.
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1.3 External Control of SoftStep3
SoftStep Key LEDs and Alphanumeric Display can be controlled remotely, and the SoftStep responds to 
Program Change messages sent to the SoftStep Control Surface port.

Controlling SoftStep LEDs
The SoftStep’s LEDs can be controlled from an external software or hardware source using CC messages. 
Each numbered key has a red and green LED that respond to the following messages:

Red LEDs

CCs 20-29 control the red LEDs on keys 0-9 (one CC per key). CCs accompanied with a value of: 

0 = LED Off

1 = LED On

2 = LED Fast Flash

3 = LED Slow Flash

Green LEDs

CCs 110-119 control the green LEDs on keys 0-9 (one CC per key). CCs accompanied with a value of:

0 = LED Off

1 = LED On

2 = LED Fast Flash

3 = LED Slow Flash

  Note: When sending MIDI via USB, CCs should be sent to the SoftStep Control Surface port.

Controlling SoftStep Display
In addition to the key LEDs, the four-character display on the SoftStep can also be controlled via external 
software using CC messages sent to the SoftStep Control Surface port. 

The four characters on the display are addressed using four CC messages:

CC 50 = first character

CC 51 = second character

CC 52 = third character

CC 53 = fourth character



SoftStep3 Hardware

13

SoftStep3

Each CC should be sent with a value between 48 and 122. These values correspond to the following:

48-57 = Numbers 0-9

65-90 = Capital letters A-Z

97-122 = Lowercase letters a-z

58-64 & 91-96 = various symbols/characters

For example, to make the third character on the display show the number “3”, send CC 52 with a value of 51.

Changing Presets With Program Changes
When in Standalone mode, Program Change messages 1 through 16 sent to the SoftStep Control Surface 
port will select the corresponding preset in the setlist — e.g. sending program change 7 will load the seventh 
preset in the setlist.

When in Hosted mode, Program Change messages 1 through 16 sent to the SoftStep Share port on Channel 
16 will select the corresponding preset in the setlist.
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1.4 Calibrating Expression Pedal and CV Outs
You can calibrate the expression pedal range and CV voltage output with the SoftStep Editor software. Both 
calibration windows can be opened from the “Hardware” menu item.

Calibrating Expression Pedal
An expression pedal plugged into the SoftStep can be used as a source to control MIDI parameters. Please 
calibrate your expression pedal to ensure that you have access to the full range of values. 

To calibrate the expression pedal:

1.	 Plug in your expression pedal. Make sure it is an expression pedal, a volume pedal will not work.

2.	 Adjust the expression pedal from heel to toe and observe the live values on the left slider. The middle 
slider adjusts the min and max thresholds, and the right slider shows the calibrated output value.

3.	 Put the expression pedal at the zero (heel) position. Adjust the min threshold (middle slider, bottom/
blue handle) until the output slider value is zero.

4.	 Put the expression pedal at the max (toe) position. Adjust the max threshold (middle slider, top/red 
handle) until the output slider value is 127.

5.	 When satisfied, click [save] to send the calibration values to the device.
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Calibrating CV Outs
The voltage sent from the CV Outs can be fine-tuned to accomodate drifting oscillators and non-western or 
experimental tonalities. Calibration happens by octave or by note with the help of the “Calibrate CV Outs” 
window.

Each 12bit value (0-4095) is a scaling calibration value for the listed voltage. 
 
To calibrate a voltage value, measure the CV out with a precision voltmeter, or connect it to a trusted 
oscillator and measure the pitches with a tuner. When you adjust a value, the CV is immediately updated so 
that it can be measured in real time.  
 
You can directly control the CVs with 12 bit values by using NRPN 1 for CV1, and NRPN2 for CV2.  
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Basic Editor vs. Advanced Editor
There are two different versions of the SoftStep Editor software, the “Basic Editor” and the “Advanced Editor”. 
The SoftStep offers a high degree of flexibility and customization, and as they say, “with great power comes 
great potential to make a tangled mess of things.” To this end, we created the Basic Editor to simplify the act of 
programming the SoftStep. When using the Basic Editor, each key can perform 1 simple function. CV controls 
are not supported by the Basic Editor. For more advanced usage and access to all the SoftStep features, use the 
Advanced Editor.

SoftStep Basic Editor Overview

The SoftStep Basic Editor is a great way to customize SoftStep presets when quick, simple functions are desired. 
The Basic Editor offers ten presets where each key performs a single function. Keys can output a MIDI note, act as 
a CC toggle, output key pressure, send X/Y location data, send program change messages, or emulate a vertical 
slider — users’ most common needs.

2.1 Keys
This is where the behavior of the SoftStep keys are defined. The keys are laid out in the Editor as they appear on 
the SoftStep hardware.

MIDI Message Type
When using the Basic Editor, each Key sends 1 MIDI message. There are six available MIDI Message types:

•	 MIDI Note - send a MIDI Note at set velocity, either momentary or toggle.

•	 Pressure - send a pressure value on a set CC#, with smoothing.

•	 Toggle - toggle a CC# between two set values, hi and lo.

•	 X/Y - send live values for X- and Y- pressure on set CC#s, with latching.

•	 Y Inc - increment and decrement the value of a set CC# with Y-axis pressure.

•	 Program - send Bank and Program Change messages

Deactivate a key by clicking on the radio button to toggle the selection off.
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MIDI Message Parameters
Selecting a MIDI Message Type will show its editable parameters. 

Each message type has different parameters. MIDI Note, for example, allows selecting the note number, velocity, 
and whether or not it should toggle when the key is pressed. X/Y allows selecting a CC number for both the X 
and Y parameters, and whether or not the CCs should latch when the key is released..

Key Name
Enter up to four characters to give the key a name. This name will be used on the SoftStep display in certain 
situations. For detailed information on how the display behaves for each message type, please see the Display 
Behavior section.

2.2 Settings 
Connected Indicator
Displays whether or not the Editor has made a connection to an attached SoftStep controller. A connection is 
required to use update firmware, send presets to the SoftStep, and alter the SoftStep’s settings. A connection is 
not needed to edit or manage presets.

MIDI Thru
Routes incoming MIDI from the SoftStep to another MIDI device so that you can audition changes made in the 
editor software.

Note for Windows Users: An error message will pop up and stop you if you attempt to select a MIDI port that is 
already in use.

Sensitivity
Adjusts the sensitivity of the SoftStep. This number acts as a multiplier on the sensor data; higher values are 
more sensitive — lower values are less sensitive. Range: 0.5 - 2.55, Default Value: 1.00

Backlight
Turns the SoftStep backlighting on or off. Check this box to turn it on — uncheck this box to turn it off.

MIDI Channel
Sets the MIDI channel the SoftStep will send MIDI on. Range: 1-16, Default Value: 1

Nav Pad CC#
In the Basic Editor, the Nav Pad’s behavior is not customizable (aside from the CC  number). In each preset, the 
Nav Pad behaves as though it is set to Y Inc — pressing up on the Nav Pad will increment the CC value (between 
0-127), and pressing down on the Nav Pad will decrement the CC value. Set which CC# the Nav Pad is sending 
on using this Nav Pad CC # number box.
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Pedal CC#
Sets the CC number that a connected expression pedal will send MIDI on. All Basic Editor presets have 
expression pedal functionality enabled.

Display Name
Sets the display name for the currently selected preset. This name will be displayed when switching between 
presets on the SoftStep, so a unique, identifiable name is recommended. Up to four characters may be used.

2.3 Presets

Current Preset
Selects a preset for editing. The Basic Editor allows for ten different presets, 1-10. 

Save Button
Saves any changes made to the current preset. The save button will light up red if any unsaved changes have 
been made.

Revert Button
Restores a preset to its saved state. Any unsaved changes will be lost.

2.4 Menu Bar
A number of useful functions and settings can be accessed via the menu bar at the top of the screen (Mac OS) or 
at the top of the application window (Windows). Manage presets, copy/paste keys, manage firmware, and more.

About SoftStep Basic Editor
Found in the application menu (MacOS) or in the Help menu (Windows). Displays version information about 
the SoftStep Basic Editor.

Editor Version: Displays the version number of the editor.

Expected: Displays which firmware version is provided in this version of the Basic Editor. This is the 
version that will be loaded onto a connected SoftStep when a firmware update is initiated.

Found: Displays the firmware version currently loaded on a connected SoftStep.

File
The File menu contains options related to exporting/importing files.
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Export Preset

Allows for exporting the currently selected preset as a file. The resulting .softstepbasicpreset file can later be 
imported to the Basic Editor. Great for backups and moving presets to another computer!

Import Preset

Allows importing a .softstepbasicpreset file over the currently selected preset. When importing, the current 
preset’s parameters will be altered but not saved (so the revert button can always be used to undo the 
changes).

Edit
The Edit menu contains options related to modifying presets in some way.

Copy Preset

Copies all of the current preset’s settings (to be used for pasting later).

Paste Preset

Applies a copied preset’s settings to the currently selected preset.

Use Custom Preset

The currently selected preset will use the Basic Editor to create a custom preset.

Use Factory Preset

Use this to choose a factory preset (from the Advanced Editor) to use in place of the currently selected Basic 
Editor preset. When using a factory preset, the Keys area will grey out and display the text: “Using Factory 
Preset: [preset name here]”.

Hardware
The Hardware menu contains options related to the SoftStep pedal itself.

Update/Reload Firmware

This option will manually initiate a firmware update/reinstallation.

Help
The Help menu contains options related to documentation/information.

Documentation

Navigates to the SoftStep documentation using the default web browser.

Show/Hide Tooltips

Selecting this option will toggle between hiding and showing the tooltip pop ups displayed when hovering 
the mouse cursor over an object.



SoftStep Advanced Editor

d9d8d6



SoftStep Advanced Editor

22

SoftStep3

Advanced Editor
While the Basic Editor covers the most commonly used functions, sometimes more complex setups are desired — 
that is where the Advanced Editor comes into play.

The SoftStep Advanced Editor allows for up to 16 fully customizable presets — each key can have multiple functions, 
LED behavior can be customized, and more sensor response settings allow for fine-tuning the SoftStep’s playability.

3.1 Hosted vs. Standalone
The SoftStep Advanced Editor can operate in two different modes, Hosted mode and Standalone mode.

Hosted Mode
In Hosted mode, the SoftStep hardware is tethered to the SoftStep Editor software. The SoftStep sends raw 
sensor data to the SoftStep Editor, and the Editor then processes it into the correct MIDI messages (as defined by 
the modlines), then outputs it over the virtual MIDI port, SoftStep Share. (Windows users should see the SoftStep 
Share section for more info on Virtual MIDI Ports).

Hosted Mode has more features and options available, but requires the SoftStep be connected to the Editor to 
function. These features include...

State Recall

State recall is only available in Hosted mode. X/Y Increment, toggle, and LED states will be remembered 
when switching between presets.

Live Editor Feedback

When running the editor in Hosted mode the modlines provide live feedback — the raw, result, and value 
number boxes update in real time.

Modline Sources and Message Types

Hosted mode has more options in the modline Source list. Hosted Mode only sources include MIDI A-H, Top, 
Bottom, the trigger latch sources, and a variety of Nav Pad sources. Message types only available in Hosted 
mode include OSC, Garageband, Aftertouch, Poly Aftertouch, Y Inc Set, and X Inc Set.

A complete list of sources and messages types can be found in the Sources and Message Types section.

Adjacent Key Lockout

The Adjacent Key Lockout key safety setting is only available in Hosted mode.

Standalone Mode
When in Standalone mode, all MIDI data comes directly from the SoftStep. The Editor does not need to be 
running in order to operate the SoftStep in Standalone mode. Standalone mode can function without being 
plugged into a computer at all.
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Display Mode Setting

The Display Mode switches the display toggled the MIDI offset to display 0-127 or 1-128. The same effect can 
be created in Hosted mode using some fancy modline work.

Disabling Scene Changing

The Scene Changing On/Off setting is only available in Standalone mode.

Output Ports
An important distinction between Hosted and Standalone mode is which output port to use. “SoftStep Control 
Surface” should be used in Standalone mode (data coming directly from the SoftStep), and the virtual port 
“SoftStep Share” should be used in Hosted mode (data coming from the editor).

Note: SoftStep Share is a virtual MIDI port built into the Mac OS version of the Advanced Editor. Windows users 
will need to install and use a third-party MIDI bus, like LoopMIDI. More information can be found in the SoftStep 
Share section.

3.2 Main Window Overview
The Main Window is displayed when you open the Advanced Editor software. This is the gateway to everything — 
customizing keys, opening the settings and setlist windows, and preset management.

(1) Key Boxes
The key boxes in the Advanced Editor’s main window are laid out just as the keys on the SoftStep hardware are 
— keys 1-5 on the bottom row, keys 6-0 on the top row (and Nav Pad to the right). Clicking on a Key Box will open 
the Key Modulation Window for that key.

1 2

3 4

5 6 7

8
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(2) Display Name Box
The display name box is used to set the name that appears on the SoftStep’s display when a preset is loaded 
(four characters maximum).

(3) Preset Section
Select a preset from the drop down menu. Save or Save As, Revert or Delete presets.

(4) Hosted/Standalone Switch
Switch between Hosted and Standalone mode.

(5) Setlist Button
Opens the Setlist window, where you set the order of the presets saved to the SoftStep.

(6) Settings Button
Opens the Settings window to adjust global SoftStep settings.

(7) Connection Indicator
“SoftStep Connected” will display when a SoftStep is plugged in and recognized by the Editor software.

(8) CV Section
Set the CV messages that will go out the two CV outputs.
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3.3 Key Modulation Window Overview
The main part of a modulation window is the modline area. Modlines tell the SoftStep keys what they should do — 
select the type of data, how to process the data, and how to output the data.

Each key can have up to 6 active modlines — each performing a completely different function.  Information travels 
from left to right through the modline.

Click the radio button to the left of the modline to toggle the modine on/off.

 Click +/- to add or remove modlines from the Key.

Inits (Hosted Mode only)
Inits allow for initializing parameters/modlines when a preset is loaded. Inits consist of two parts: a mode and a 
value.

The mode defines if and when the init is triggered. The value is the number output when the init is triggered. The 
following mode options are available:

•	 “None”, No initialization value will be output.

•	 “Always”, Outputs the init value every time the preset this is placed on is loaded.

•	 “Once”, Outputs the init value the first time the preset this is placed on is loaded. Switching to this preset 
again will not output the init value. This applies per session — “Once” will only reset by quitting the 
Advanced Editor and reopening it.

Data Sources
The Data Sources section of the modline selects what type of SoftStep sensor data to use. When in Hosted Mode, 
the “Raw” number box will show the live raw data value coming from the selected data source.

The following data sources are available for Keys:

Pressure Live

Outputs the amount of pressure currently being applied to the key. Range: 0-127

X Live

Outputs the amount of left-to-right (x-axis) pressure being applied to the key. The value will return to center 
(64) when the key is released. Range: 0-127 (left to right)
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Y Live

Outputs the amount of bottom-to-top pressure (y-axis) currently being applied to the key. The value will return 
to center (64) when the key is released. Range: 0-127 (bottom to top)

Pressure Latch

Outputs the amount of pressure being applied to the key, but the value latches and stays wherever it is when 
the key is released. Range: 0-127

X Latch

A latching version of the X Live source — the value stays where it is when the key is released. Range: 0-127

Y Latch

A latching version of the Y Live source — the value stays where it is when the key is released. Range: 0-127

X Increment

Applying pressure left-right will increase or decrease the value at a rate determined by the “x inc speed” set in 
the “Keys” tab of the “Settings” window. Range: 0-127

Y Increment

Applying pressure up-down will increase or decrease the value at a rate determined by the “y inc speed” set in 
the “Keys” tab of the “Settings” window. Range: 0-127

Foot On

Outputs a 127 when the key is pressed and a 0 when the key is released.

Foot Off

The inverse of Foot On — outputs a 0 when the key is pressed and a 127 when the key is released.

Random

Outputs a continuous stream of random values when pressure is applied to the key.

Random Singles

Outputs a single random value when you press on the key.

Dbl Trig

Two quick presses of the key will output a value of 127 followed by a value of 0 100ms later.
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Long Trig

Pressing and holding the key for 1 second will output a value of 127 followed by a value of 0 100ms later.

Top (Hosted mode only)
Outputs a 127 when the top half of the key is pressed and a 0 when the key is released.

Bottom (Hosted mode only)
Outputs a 127 when the bottom half of the key is pressed and a 0 when the key is released.

Fast Trig (Hosted mode only)
Pressing the key immediately outputs a 127 followed by a 0 (100ms later).

Off Trig (Hosted mode only)
Outputs a 127 followed by a 0 (100ms later) when the key is released.

Fast Trig Latch (Hosted mode only)
Immediately outputs a 127 when the key is pressed. Does not go back to 0.

Dbl Trig Latch (Hosted mode only)
Two quick presses of the key will output a 127. Does not go back to 0.

Long Trig Latch (Hosted mode only)
Pressing and holding the key for 1 second will output a 127. Does not go back to 0.

Pedal

If an expression pedal is connected, this source will output the current value coming from the pedal.

Init (Standalone mode only)
Outputs a 127 whenever the current preset is loaded. Useful for initializing values whenever a specific preset 
is loaded. Use the min and max options (or offset) in the modlines to send a specific value.

Nav Yx10 & Key

Works in tandem with the Nav Pad. The Nav Pad must also be in Program Change mode or using the Nav Y 
Decade source.

The Nav Pad’s current counter value is multiplied by 10 to get a “decade” — e.g. 20s, 30s, 40s, etc., then the 
key number (this source is placed on) is added to the value when pressed.
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Key 0-9 Pressed

Outputs a 127 when the corresponding key is pressed — e.g. Key 4 Pressed will output a 127 whenever 
key 4 is pressed. This source is great for turning other keys’ LEDs on/off.

Other Key Pressed

Placing this on a key will output a 127 when a different key is pressed, and output a 0 when the key this is 
assigned to is pressed. Example: place this on key 2 — it will output a 0 when key 2 is pressed and output a 
127 when any other key is pressed.

Modline 1-6 Output

Uses the final output value from another modline (1-6) and sends it through the modline this source is 
assigned to. Great if any extra data processing for more complex setups is needed.

MIDI A-H (Hosted mode only)
Receives the values from the MIDI inputs assigned in the Settings window and passes them through the 
modline.

OSC A-H (Hosted mode only)
Receives the values from the OSC inputs assigned in the Settings window and passes them through the 
modline.

Data Modifiers
Data flowing from the sensor source runs through a series of modifiers to scale, constrain and otherwise 
shape the values being sent to the Output Settings section of the modline.

Gain

Multiplies incoming values by the specified amount. Defaults to 1.00.

Offset

Adds the specified amount to incoming values. Use negative numbers for subtraction. Defaults to 0.

Result (Hosted mode only)
A live display of the modline values after passing through the gain and offset stage.
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Table

Sets the shape of the lookup table applied to incoming values. Also used for toggle behavior, and 
interacting with the key counter. The following tables are available:

•	 Linear - A 1:1, linear table. Values passing through will not be modified in any way.

•	 Sine - Applies a sine curve to incoming values.

•	 Cosine - Applies a cosine curve to incoming values.

•	 Exponential - An exponential curve. Lower values rise slowly, higher values rise quickly.

•	 Logarithmic - A logarithmic curve. Lower values rise quickly, higher values rise slowly.

•	 Toggle - Alternates between 127 and 0 values whenever a positive value transition (e.g. 0 to 127, 
or 1 to 2) passes through the modline. Using the Foot On source with the Toggle table makes a 
great toggle switch!

•	 Counter Inc - (Hosted mode only) Increments the key’s counter and outputs the value when a 
positive value transition is sent through the modline.

•	 Counter Dec - (Hosted mode only) Decrements the key’s counter and outputs the value when a 0 
to positive value transition (e.g. 0 to 127) is sent through the modline.

•	 Counter Set - (Hosted mode only) Immediately sets (and outputs) the key’s counter to the value 
coming through the modline.

•	 Random - Applies a random lookup table. 

•	 Scales - Major, Natural Minor, Harmonic Minor, Dorian, Phrygian, Lydian, Mixolydian, and Locrian.

Min

Sets the minimum value that can be output. All values below the minimum will be clipped to this value.

Max

Sets the maximum value that can be output. All values above the maximum will be clipped to this value.

Smooth

Adds smoothing to the data. Set the amount of time (in milliseconds) it takes to slide/interpolate to 
the next value. Smaller values can smooth out jumpy data, while larger values can create longer ramps 
between values. Range: 0 - 5000ms.

Delay (Hosted mode only)
Applies a delay to the data. Set the amount of time (in milliseconds) to delay the incoming values. Range: 
0 - 5000ms.

Value (Hosted mode only)
A live display of the modline values after passing through the data modifiers section.
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Output Settings
The Output Settings section is where you set the MIDI Message Type that will be sent, and the Output Port it 
will be sent on.

Message Type

Message Types select what kind of MIDI message the modline will output (there are also a couple of other 
message types, but MIDI is the most common). 

Each Message Type has options that further define how the message type should behave — e.g. what MIDI 
note number and velocity to output, what CC number to send on, or what channel to output program 
change values on.

The following Message Types are available:

None

No message will be output. This is helpful if the modline is only controlling LED behavior or being 
further processed using one of the Modline 1-6 Output sources.

Note Set

Outputs a MIDI note with a specified velocity. A positive value will send a Note On message, a value of 
0 will send a Note Off message. The following options are available when Note Set is selected:

Note - Sets the note number to be output.

Vel - Sets the velocity value to be output with the note on messages.

Ch - Sets the MIDI channel to output the note messages on.

Note Live

Outputs MIDI notes with a specified velocity. The note number is determined by the values coming 
through the modline. The following options are available when Note Live is selected:

Vel - Sets the velocity value to be output with the note on messages.

Ch - Sets the MIDI channel to output the note messages on.

CC
Outputs values on a specified Control Change (CC) number. The following options are available when 
CC is selected:

CC# - Sets the CC number to send the messages on.

Ch - Sets the MIDI channel to output the CC messages on.
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Bank

Outputs values as MIDI bank select messages. The following options are available when Bank is 
selected:

MSB - Sets the MSB of the bank message.

Ch - Sets the MIDI channel to output the bank select messages on.

Note: Bank Select messages are 14-bit resolution (a range of 0-16383), as opposed to the standard 
7-bit MIDI message (range 0-127). This is accomplished by using two separate messages: a MSB (most 
significant bit) and an LSB (least significant bit). With SoftStep, values passing through the modline will 
set the LSB of the bank message — the MSB must be fixed at a specified value (using the MSB option).

Program

Outputs values as MIDI program change messages. The following options are available when Program 
is selected:

Ch - Sets the MIDI channel to output the program change messages on.

Pitch Bend

Outputs values as MIDI pitch bend messages.

•	 0 = full bend down

•	 64 = center (no bend) 

•	 127 = full bend up

The following options are available when Pitch Bend is selected:

Ch - Sets the MIDI channel to output the pitch bend messages on.

MMC
Used to send MIDI Machine Control (MMC) messages. The following options are available when MMC 
is selected:

ID - Sets the device ID number for the MMC message. Each MMC-capable device should have a 
unique ID number (most devices/software allow the user to set the ID number in case of conflicts).

Function - Sets the MMC function/command that should be sent.  The following MMC commands 
are available:

•	 Stop

•	 Play

•	 Deferred Play

•	 Fast Forward

•	 Rewind
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•	 Punch In

•	 Punch Out

•	 Pause

OSC (Hosted mode only)
Outputs values as an OSC message with a specified prefix. OSC settings such as input port, output 
port, output IP address can be set in the OSC tab of the Settings window. The following options are 
available when OSC is selected:

Output Prefix - Sets the prefix to output with the OSC message. A prefix typically begins with a 
“/” character, e.g. /softstep or /controller. Defaults to “/softstep” (no quotes) when no prefix is 
specified.

Aftertouch (Hosted mode only)
Outputs values as MIDI aftertouch messages. The following options are available when Aftertouch is 
selected:

Ch - Sets the MIDI channel to output the aftertouch messages on.

Poly Aftertouch (Hosted mode only)
Outputs values as MIDI polyphonic aftertouch messages. The following options are available when 
Poly Aftertouch is selected:

Note - Sets the note number to associate with the poly aftertouch message.

Ch - Sets the MIDI channel to output the poly aftertouch messages on.

Y Inc Set (Hosted mode only)
Sets a key’s Y Increment value. Any value going through the modline will instantly set the current key’s 
Y Increment value. Useful for initializing Y Increment values from other keys or preset changes.

X Inc Set (Hosted mode only)
Sets a key’s X Increment value. Any value going through the modline will instantly set the current key’s 
X Increment value. Useful for initializing X Increment values from other keys or preset changes.
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Output Port

Select the MIDI port/device the modline messages will be sent out to. 

SoftStep USB MIDI Port (Standalone Only)
The SoftStep USB MIDI port is used to send data from the SoftStep to your computer.

SoftStep Share Port (Hosted Only)
SoftStep Share is a virtual MIDI port provided with the Mac OS version of the Advanced Editor. It is 
used as an inter-application MIDI bus — it routes MIDI from the editor to other applications.

The Windows version of the Advanced Editor does not come with a built-in virtual MIDI port — users 
will have to download and install a third-party MIDI bus of their choice. If you do not have a virtual 
MIDI Port named “SoftStep Share” when you enter Hosted Mode, you will be prompted to download a 
third party application, LoopMIDI, to create a virtual port.

SoftStep TRS MIDI Out Port

The SoftStep TRS MIDI Out port is used to send data to external hardware attached to the SoftStep TRS 
MIDI Out port.

SoftStep CV Out Port

The SoftStep CV Out port is used to send data to external hardware attached to the SoftStep CV Out 
port.
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LED+Display Settings
The LED+Display Settings section can be accessed by clicking the LED+DISPLAY SETTINGS button in the 
top-right corner of the key modulation window. These settings define how the SoftStep Key LEDs behave, 
and how the SoftStep display behaves when the key is pressed.

When displayed, the LED+Display Settings look like this:

Key Name

Sets the name of the key. Key names appear on the SoftStep display as defined by the Display Mode 
option. Key names can also be edited in the key box area of the editor’s Main Window.

Display Mode

Sets how the Key Name appears on the Display when the key is pressed. For a complete list of all 
available Display modes and their behavior, see the Display Modes section

Prefix

One or two characters that can be added in front of the parameter value on the SoftStep’s display — 
e.g. with a prefix of “FF” and a modline value of 57, the display would read “FF57”. Leave blank for no 
prefix.

Green LED
Sets the behavior of the key’s green LED. For a complete list of all available LED modes and their 
behavior, see the LED Modes section.

Red LED
Sets the behavior of the key’s red LED. For a complete list of all available LED modes and their 
behavior, see the LED Modes section.

Active Display Modline Selector

Selects which modline’s data will be used for the Display mode settings. Only one modline can be 
selected per key.
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Display Modes

You can set how the “Key Name is displayed on the SoftStep display with the “Display Mode”

None

Has no effect on the SoftStep display. Stepping on a key with None selected will show the current 
preset name.

Always

Displays the key name whenever the key is pressed. The key prefix and parameter value are not used 
in this mode.

Once (Hosted mode only)
The key name will be displayed as soon as the key is pressed for the first time, after a brief period the 
prefix and parameter value will be displayed. Any subsequent key presses will display the prefix and 
parameter value.

Initial/Return

The key name will be displayed as soon as the key is pressed. After a brief period the prefix and 
parameter value will be displayed.

Immed Param

Displays the key’s prefix and parameter value whenever the key is pressed.

LED Modes

The LED mode defines how the SoftStep’s LEDs behave. Tell them when to turn on, when to turn off, and 
more. Each of the following options are available in the Advanced Editor for both the green and red LEDs:

None

Has no effect on the LED state. If the LED is currently on, it will stay on — if it’s off, it will stay off.

True

The LED will turn on when the modline value is 1 or greater. It will turn off when the modline value is 
equal to 0.

False

The LED will turn on when the modline value is equal to 0. The LED will turn on when the modline 
value is 1 or greater.

Flash True

The LED will continuously flash when the modline value is 1 or greater. It will turn off when the modline 
value is equal to 0.
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Flash False

The LED will continuously flash when the modline is equal to 0. It will turn off when the modline value 
is 1 or greater.

Flash Fast True

The LED will continuously flash quickly when the modline value is 1 or greater. It will turn off when the 
modline value is equal to 0.

Flash Fast False

The LED will continuously flash quickly when the modline value is equal to 0. It will turn off when the 
modline value is 1 or greater.

Blink True

The LED will blink once when the modline value is 1 or greater. Nothing will happen when the modline 
value is equal to 0.

Blink False

The LED will blink once when the modline value is equal to 0. Nothing will happen when the modline 
value is 1 or greater.

Off

Turns the LED off when a value of 1 or greater is received

Nav Pad Modulation Window
The Nav Pad’s modulation window has a few differences from the other keys’ modulation windows Most 
significantly, the Nav Pad has a Mode setting in the top-left corner with two options:

•	 Modline: Use the Nav Pad with the modlines like a normal key.

•	 Program Change: This mode allows the Nav Pad to count “decades” in increments of 10 from the Min 
to the Max Count values for use with the Nav Yx10 & Key source — This option will disable the use of 
modlines on the Nav Pad.

The Nav Pad also has unique Data Sources. The following sources are exclusive to the Nav Pad:

Nav Y(Hosted mode only)
Pressing up on the Nav Pad (the north key) increments the Nav Pad’s counter — pressing down on the Nav 
Pad (the south key) decrements the counter.

Nav Y Decade (Hosted mode only)
Pressing up/down on the Nav Pad increments/decrements through the Nav Pad’s counter and multiplies 
the value by 10. This results in a “decade” value (e.g. 20s, 30s, 40s, 50s, etc.). Stepping on a key using the 
Nav Yx10 & Key will then add that key number to the decade value.

The decades range can be adjusted using the min and max options in the Nav Pad counter.
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Nav Y Inc-Dec

The Nav pad version of the Y Increment source. Pressing up on the Nav Pad (the north key) increments the 
value, pressing down on the Nav Pad (the south key) decrements the value. Range: 0-127

Nav N Foot On (Hosted mode only)
One of the Nav Pad versions of the Foot On source. Outputs a 127 when pressing the north key (up) on 
the Nav Pad, outputs a 0 when released.

Nav S Foot On (Hosted mode only)
One of the Nav Pad versions of the Foot On source. Outputs a 127 when pressing the south key (down) on 
the Nav Pad, outputs a 0 when released.

Nav N Foot Off (Hosted mode only)
One of the Nav Pad versions of the Foot Off source. Outputs a 0 when pressing the north key (up) on the 
Nav pad, outputs a 127 when released.

Nav S Foot Off (Hosted mode only)
One of the Nav Pad versions of the Foot Off source. Outputs a 0 when pressing the south key (down) on 
the Nav pad, outputs a 127 when released.

Nav N Trig (Hosted mode only)
Outputs a 127 when the north key on the Nav Pad is pressed and held down for 500ms, then outputs a 0 
(100ms later).

Nav N Trig Fast (Hosted mode only)
The same as the Fast Trig source. Applies to the north key on the Nav Pad.

Nav N Trig Dbl (Hosted mode only)
The same as the Dbl Trig source. Applies to the north key on the Nav Pad.

Nav N Trig Long (Hosted mode only)
The same as the Long Trig source. Applies to the north key on the Nav Pad.

Nav S Trig (Hosted mode only)
Outputs a 127 when the south key on the Nav Pad is pressed and held down for 500ms, then outputs a 0 
(100ms later).

Nav S Trig Fast (Hosted mode only)
The same as the Fast Trig source. Applies to the south key on the Nav Pad.
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Nav S Trig Dbl (Hosted mode only)
The same as the Dbl Trig source. Applies to the south key on the Nav Pad.

Nav S Trig Long (Hosted mode only)
The same as the Long Trig source. Applies to the south key on the Nav Pad.

3.4 Control Voltage (CV)
SoftStep3 has 2 CV Outs that send control voltage signals to control modular synthesizers and other analog gear.

Mapping MIDI to CV
Configure the SoftStep3 to send CV out from various sources with 
the controls at the right side of the Main Window of the Editor 
software.

Note Mode

Set the CV Out response to NOTE messages received at the 
SoftStep CV Out port

•	 Gate = 5V for Note On, 0V when all notes are released

•	 Pitch = 0-5V scaled to IV/Oct

•	 Velocity = 0-5V representing the velocity value of the 
note

•	 Disabled - all Note On/Off messages are ignored

All notes off (CC#123) and transport STOP messages will turn 
all gates off.

Control Msg

Control the CV out with MIDI messages received at the SoftStep CV Out port.

•	 Pitch Bend - values from key modlines are scaled up from 0-127 to the 12bit CV DAC. USB 
messages are scaled down from 14bits.

•	 Mod Wheel - CC#1 vales are scaled up from 0-127 to the 12bit CV DAC

•	 Aftertouch - Channel pressure is scaled up from 0-127 to the 12bit CV DAC

•	 Disabled - all of the above messages are ignored

MIDI Channel

The CV responds to key modline and/or USB messages sent on this channel.
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Sources

The CV can respond to messages from the SoftStep keys, from the “SoftStep CV” USB MIDI port, or both.

Note: in Hosted mode, keys/modlines can only control the CV outs by sending messages to the “SoftStep 
CV” USB MIDI port.

3.5 Preset Management
It is important to note at the start that presets created in Hosted Mode are distinct from presets created in 
Standalone Mode. Presets made in one mode will not work in the other mode. The list of saved presets and 
Setlist are also distinct to each mode. Switching between modes automatically switches the preset lists over 
accordingly.

In Hosted Mode, the SoftStep is tethered to the Editor software. Changes made to the preset update in real-time. 
Pressing left and right on the Nav Pad moves through presets selected in the Setlist.

In Standalone mode, the SoftStep stores a Setlist of up to 16 presets in its internal memory and does not need to 
be connected to a computer with the Editor running. Changes made to a preset do not update live and need to 
be saved in the Setlist and sent to the SoftStep to update.

Preset Section
The Presets Section is in the top-left area of the Advanced Editor Main Window. This where presets are saved, 
reverted or deleted. This is also where you click to send the Preset Setlist if you are using the SoftStep in 
Standalone mode.

Preset selection drop-down

Clicking this displays a list of all presets. Choosing one loads it as the currently active preset.

Save button

Saves any changes made to the current preset when clicked. The save button will light up red if any 
unsaved changes have been made.

Save As button

Saves any changes made to the current preset to a new preset when clicked. The preset that was 
previously being edited will revert to its last saved state.
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Revert button

Restores a preset to its last saved state. Any unsaved changes will be lost.

Delete button

Deletes the currently selected preset. A confirmation dialogue will appear when clicked to prevent 
accidental deletions.

Send to SoftStep button (Standalone mode only)
Updates the connected SoftStep with any presets currently in the setlist. In Hosted Mode this button is 
disabled and greyed out.

Preset Setlist
Press the “Setlist” button in the Main Window to open the Setlist 
window. The Setlist is the selection and order of presets sent to the 
internal memory of the SoftStep hardware. The Setlist allows up to 16 
presets to be selected and ordered. This is the order that the presets 
will appear on the SoftStep when pressing the left and right keys on 
the Nav Pad.

Select a Preset from the dropdown menu to place it in the Setlist. 
Clicking on the blue number button will empty that preset slot.

Importing and Exporting Presets
Presets can be saved and shared by exporting and importing 
“.softsteppreset” files. Import and Export presets from the File menu.

Editor Preset Directory
Selecting “Editor Preset Directory” from the File menu opens the 
folder where the presets, setlist and settings are stored. If you delete 
the contents of this folder, the Editor will rebuild this folder with the 
“factory default” presets the next time it is opened.
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3.6 Settings Window
Access the Settings Window by pressing the Settings button. The “GLOBAL”, “KEYS”, and “INPUT” buttons at the 
top open the corresponding tabs in the Settings window. 

Changes made in the Settings menu are sent to the connected SoftStep in real-time (eg, sensitivity adjustments 
or backlighting.)

Global Tab
The Global tab contains settings that apply to the entire SoftStep. Turn the backlighting on/off,  adjust the 
sensor response, change the sensitivity, and more.

Backlight Brightness

Adjust the brightness of the SoftStep LEDs.

Scene Changing On/Off 
Enables/Disables scene changing using the Nav Pad Left and 
Right keys. Standalone Mode only.

Sensor Response

Sets how the SoftStep sensors (four per key) determine overall 
key pressure.

•	 Maximum: Looks at only the highest valued sensor to 
determine key pressure.

•	 Average: Averages the four sensors together to 
determine key pressure.

Display Mode Switch 
Switches the SoftStep display behavior for program change 
messages. Data can be displayed in the 0-127 range or the 1-128 range. Standalone Mode only.

Key Safety Mode

Sets how many keys can be activated simultaneously.

•	 Single Key: Only one key can be activated at a time.

•	 Adjacent Lockout: (Hosted mode only) Keys immediately adjacent to an activated SoftStep key 
cannot be triggered.

•	 All Keys: Any key can be activated at any time.

Sensitivity Adjustment

Adjusts the sensitivity of the SoftStep. Moving the slider to the right (toward the “+” symbol) increases 
sensitivity — moving the slider to the left (toward the “-” symbol) decreases sensitivity.

Clicking the RESET SENSITIVITY button will reset the sensitivity slider to its default value.
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Keys Tab
The Keys tab contains settings that apply to individual SoftStep Keys and the Nav Pad. Adjust the On and Off 
Thresholds and X/Y Increment speeds per key or Nav Pad direction. 

X Inc Speed

Sets the speed at which the X Increment source increments/
decrements. Higher values make the source move faster — 
lower values make the source move slower.

Y Inc Speed

Sets the speed at which the Y Increment source increments/
decrements. Higher values make the source move faster — 
lower values make the source move slower.

On Threshold

Sets the amount of pressure necessary to consider the key “on” 
(or “triggered”). Higher values require more pressure — lower 
values require less pressure.

Off Threshold

Sets the amount of pressure necessary to consider the key “off” 
(or “released”). Higher values will make the key turn off sooner 
(pressure doesn’t have to drop much) — lower values will make 
the key turn off later (pressure has to drop very low).
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Input Tab
The Input tab contains MIDI and OSC input options (when in Hosted Mode), as well as a MIDI THRU  Port 
(when in Standalone Mode).

MIDI Input (Hosted mode only)
The MIDI Input section contains options for receiving MIDI from 
other connected MIDI devices or software. There are 8 MIDI 
inputs available (A-H) that can be accessed in the modlines by 
using the MIDI A-H sources. Toggle inputs on and off with the 
“enable” checkbox.

•	 Device sets the MIDI device to receive data from.

•	 Channel sets the MIDI channel to listen for. All MIDI coming 
in on other channels will be ignored.

•	 Message Type sets the message type to listen for. All other 
message types will be ignored. 

•	 # Sets the specific note/CC/program change number to 
listen for. All other numbers will be ignored.

OSC Input (Hosted mode only)
The OSC Input section contains options for receiving (and one 
sending option) OSC from other OSC-capable software/devices. 
There are 8 OSC inputs available — A through H. These can be 
accessed in the modlines by using the OSC A-H sources.

•	 Enable toggles this OSC input on/off.

•	 Prefix sets the OSC prefix to listen for. All other prefixes will be ignored.

•	 Value is a live display of the incoming value. This is the value that will get passed to the modlines 
when using the OSC A-H sources.

•	 Sending IP Address sets the IP address that OSC messages will be output on. (Default: 127.0.0.1)

•	 Out Port sets the port number OSC will be output on. (Default: 7000)

•	 In Port sets the port number to listen to for incoming OSC messages. (Default: 7001)

MIDI THRU Port (Standalone Mode only) 

MIDI THRU routes the incoming MIDI from the SS to another MIDI device so that you can audition your 
changes in the editor. The dropdown menu selects which MIDI device to route the MIDI data to.

 Note: An error message will pop up and stop you if you attempt to select a MIDI port that is already in 
use.
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3.7 Menu Bar
There are a number of useful functions and settings that can be accessed via the menu bar at the top of the 
screen (Mac OS) or at the top of the application window (Windows). Manage presets, copy/paste keys, manage 
firmware, and more.

About SoftStep Advanced Editor
Found in the application menu (MacOS) or in the Help menu (Windows). Displays version information about 
the SoftStep Basic Editor.

File

Export Preset

Exports the currently selected preset to an external file on the hard disk. Good for sending presets to a 
friend, transferring presets to a new computer, or creating a preset backup. The resulting .softsteppreset 
file can be imported to the Advanced Editor using the Import Preset function (also located in the File 
menu).

Import Preset

Imports a .softsteppreset file. Use this when restoring presets from backup, importing a preset from a 
friend, or importing presets from an older computer.

Import Hosted/Standalone Presets From v1.21
Allows importing presets from the previous SoftStep Editor — version 1.21.

1.	 Select “Import Hosted/Standalone Presets From v1.21”

2.	 Navigate to the old editor’s “Presets” folder

3.	 Click “Choose” — the importing process will automatically begin

4.	 Click the preset selection drop-down menu

When in Hosted mode, the Hosted mode presets from 1.21 will be imported — when in Standalone 
mode, the Standalone mode presets from 1.21 will be imported. This function does not currently allow for 
importing Standalone mode presets to Hosted mode (or vice versa).

Open Editor Preset Directory

Selecting “Editor Preset Directory” from the File menu opens the folder where the presets, setlist and 
settings are stored. If you delete the contents of this folder, the Editor will rebuild this folder with the 
“factory default” presets the next time it is opened.
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Edit

Copy Preset

Copies the currently selected preset. Can be used later to paste over a preset or paste to a new preset.

Paste Preset

Pastes a copied preset to the currently selected preset. This option is only available if a preset has already 
been copied.

Note: Copy and Paste can be used to transfer presets from Hosted mode to Standalone mode (and vice 
versa). Make sure that available sources are compatible in both modes.

Paste Preset To New

Pastes a copied preset to a brand new preset. This option is only available if a preset has already been 
copied.

Copy Key

Copies the currently selected key’s settings (click a key box in the main window to select a key for 
copying).

Paste Key

Pastes the settings from a previously copied key to the currently selected key.

Hardware

Calibrate Expression Pedal

Opens the Expression Pedal Calibration Window. For more information see <link to section>

Calibrate CV Outs

Opens the CV calibration window. For more information see <link to section> 

Force Firmware Update

Forces a firmware update

Display Hardware Revision

You can select which hardware is connected, or autodetect. This will show or hide elements of the Editor 
that are not available to earlier hardware (eg the CV Out controls, LED brightness, etc).
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Ignore Firmware Version Checks 
Disables the firmware version callback in case you want to connect to the Editor with a SoftStep that has 
an older version of the firmware installed.

Warning: This feature is experimental and may product unexpected results!

Help

Troubleshoot Connection

Opens a window with a diagnostic panel to troubleshoot SoftStep connection issues. Follow the 
instructions and copy/paste the diagnostic report into a support ticket created at support.keithmcmillen.
com

Documentation

Links to a downloadable version of this manual when selected. This will open a web browser tab.

Hide/Show Tool Tips

Selecting this option will toggle between hiding and showing the tooltip pop ups displayed when 
hovering the mouse cursor over an object.

3.8 SoftStep Ports
When a SoftStep is connected to a computer, three MIDI ports are detected — SoftStep Control Surface and 
SoftStep TRS MIDI Out (or SoftStep Expander on older hardware) and SoftStep CV Out (not present on older 
hardware). The ports allow for bi-directional communication between the computer and the SoftStep, and should 
appear in any MIDI-capable application when a SoftStep is connected.

SoftStep Control Surface Port
The SoftStep Control Surface port is used to receive data from (and send data to) the SoftStep itself.

In Standalone mode, applications should listen to this port to receive MIDI coming from the SoftStep. This is 
also the port that data should be sent to for controlling the SoftStep LEDs, display, and presets.

SoftStep TRS MIDI Out Port
The SoftStep TRS MIDI Out port is used to send data to external hardware attached to the SoftStep TRS MIDI 
Out port.

SoftStep CV Out Port
The SoftStep CV Out port is used to send data to external hardware attached to the SoftStep CV Out port.
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SoftStep Control Surface Port in Hosted Mode
When operating in Hosted mode, the SoftStep Control Surface port behaves differently than it does in 
Standalone mode.

In Hosted mode, the SoftStep Control Surface port transmits the SoftStep’s raw sensor data to the editor, 
which then processes the data into the correct MIDI messages and outputs it.

Note: The SoftStep’s raw data appears as a series of MIDI CC messages — CCs 40-83 (four per key, including 
the Nav Pad). If “weird” CC messages appear when using the SoftStep in Hosted mode, the SoftStep Control 
Surface port will need to be disabled or filtered out in the software being used. Some applications allow for 
this (Ableton Live, Traktor, or Max/MSP, for example) while others do not and are just listening to all MIDI ports 
at all times (Logic and MainStage, for example). The latter can be quite tricky when trying to MIDI map.

SoftStep Share
SoftStep Share is a virtual MIDI port provided with the Mac OS version of the Advanced Editor. It is used as an 
inter-application MIDI bus — it routes MIDI from the editor to other applications.

SoftStep Share is only available (and only necessary) when in Hosted mode — audio/MIDI applications should 
listen to this port to receive MIDI (when in Hosted mode).

Using SoftStep Share is simple — it is automatically available after opening the Advanced Editor, and using it is 
just a matter of selecting “SoftStep Share” as the Output Port of the modlines.

Windows Users
The Windows version of the Advanced Editor does not come with a built-in virtual MIDI port — users will have 
to download and install a third-party MIDI bus of their choice.

If you do not have a virtual MIDI Port named “SoftStep Share” when you enter Hosted Mode, you will be 
prompted to download a third party application, LoopMIDI, to create a virtual port. 

Note: Be aware that the UAC (User Account Control) will likely need to be disabled for the installation to work.
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